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RedCrab is a freeware program.  
 
Software and manual are copyright. You can copy and pass it, but it is forbidden 
to change the software or the manual.  
 
We are not liable for any error in software or manual. Usage at your own risk. 
 
 
System requirement 
Minimum Pentium P4 and 250MB RAM.  
Operating system: Microsoft Windows.  
The following fonts: Courier New and Symbol must be installed in your system. 
These fonts belonged to Microsoft *Windows systems.  
 
No installation of the software is required. You can just copy the software to 
your system and starts the programs. 
   

Calculation range: 1.7e 308 to 5e-324 
Accuracy:   18 digits 
Display:   15 digits 
 
*Windows is a registered trademark of Microsoft Corporation. All other 
trademarks are the property of their respective owners. 
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RedCrab – The Calculator 
 
RedCrab is a scientific calculator with a full screen editor. Mathematical 
expressions are not entered here in a single command line, but writing in any 
editor position similar to a sheet of paper. 
  
The handling of the basic functions is just like a conventional calculator. There 
is no training required. Whoever can operate a pocket calculator can also use 
RedCrab without studying the manual. This guide describes fundamentally the 
advanced features which a normal calculator does not possess. 
 
 
 



1.0 Mathematical Expressions 
 
 
 

1.1 Basics 
 
You can write your formula basically at any editor position. Any expression 
may occupied any number of rows and columns. It not allowed to split a 
expression and continue in the next row. 
 
Wrong:    z = 12+14+15+20 

+5+10 

 
Correct: z = 12+14+15+20+5+10 

 
Correct: X = 12+14+15+20 

  Z = X+5+10 

 
 
 
 
RedCrab accepts different formats at the input of mathematical expressions:  
 

a) 17 + 4 

 

b) X = 17 + 4 

 

c) 17 + 4 = 

 

d) X = 17 + 4 = 

 
 



Result is displayed below, depending on the format used. Input in the editor will 
be displayed in black letters. The output of the calculator is printed in blue. 

 

a) 17 + 4 
  21 

 

b) X = 17 + 4 
  X = 21 

 

c) 17 + 4 = 21 
 

d) X = 17 + 4 = 21 
 
 
 
You can write several mathematical expressions on one work sheet. The 
expressions result displays only if terminated with equal sign.  
 
Example 1:  
 
        a+b  =108 
             

  a=27+9 =36  

             

      8*4  =32  

             

  b=12*6 =72 
 
 
Example 2: 
 
     a+b  =108 
             

  a=27+9    

             

      8*4 =32  

             

  b=12*6   

 



If no expression is terminated with an equal sign, the first result will be 
displayed below the bottom expression. 

 
Example: 
 
     a+b   

             

  a=27+9    

                         

  b=12*6   
 
 108 
 
Several mathematical expressions can be written per row.  Between each 
mathematical expression, there must either a minimum number at blank 
columns(defined in Menu Options.Column Space) or  a colon must be set. 
 
Example 1: 
 

 
 
 
 
Example 2: 
 

  
 
 
The minimum distance displayed at bottom right corner, next to the keyboard 
setting. In example 2 the minimum distance is set to 4 columns. 
 
 



An equal sign behind a formula 
is always assigned to the 
previous formula, even if the 
distance to the formula is 
greater than the column space 
setting. In the example right, the 
distance of the equal sign is up 
to eight columns, although the 
minimum distance is only four 
columns. 
 
 
 
 
Close proximity can caused unexpected errors. For error localization RedCrab 
marked the cell where an error is detected with a blue frame. It also marks the 
incorrect formula with a red frame. In the example below, an invalid assignment 
is signaled. The red box shows, however, that two formulas were joined because 
the distance is too close. The setting in this example is 4 columns, the distance 
between the formulas is only 2 columns. 
 
 

 
 

 
 
 

1.2 Simple Addition 
 
1. Enter the expression 17 + 4 
2. For result press <Ctrl + Enter> 
 
The <Ctrl+Enter> key starts RedCrab and displays the result. Alternative click 
the function panels Enter button. 
 
The display shows: 
 
 17+4 

 
 21 

 



The result is displayed below the expression, beginning in the same column. 
Results are always displayed in blue. 
 
 
  

1.4 Assignment of Values 
 

1. Enter the expression 17 + 4 + X 
2. Enter the assignment X = 43 
3. For result press <Ctrl + Enter> 
 
RedCrab displays the result:  64 
 

The display shows: 
 
 17+4+X 

 

 X=43 

 

 64 

 
The assignment can be entered at any position below the expression  

 
 
 

1.5 Equation 
 
The same expression as above, however as an equation. 
 
1. Enter the equation Z = 17 + 4  + X 
2. Enter the assignment X = 43 
3. Press <Ctrl + enter) to display the result 
 
The display shows: 
 

 Z=17+4+X 

 

 X=43 

 

 Z=64 

 
 
 



1.6 Exponent 
 

The expression: c = a2 + 42
.  

 

1. Enter the expression: c   =  a   <Ctrl + 2>  +  4  <Ctrl + 2>  
2. Press <Ctrl + Enter> to display result. 
 
The keys <Ctrl + 2> write the exponent 2. With the keys <Ctrl + 3> you can 
write the exponent 3. For use of any other values for exponents, press the 
<Ctrl+6> keys to enter the Super mode. Then enter the exponent value. Press 
<Enter> to leave super mode. 
 
  

The display shows: 
 

c=a
2
+4

2 

 

 
c=16+a2 
 

 

The example above includes no assignment for a, so RedCrab can only 
eliminate the exponent of 4. The following example shows the assignment and 
its solution. 
 
The display shows: 
 

c=a
2
+4

2
  

         

a=3      

         

c=25     
 

 
 
 



1.7 Subscript and Implied Multiplication 
 

Enter the formula: XL = ωL 
 
1. Press the following keys :  X   <Ctrl + _ >  L  <Enter>  =  <Ctrl + W>  L 

2. Enter the assignment ω=2πf ;  press the keys : <Ctrl + W> = 2  <Ctrl + P>  f 
3. Enter the assignment f = 2200 
4. Enter the assignment L=0.8 10-3; press the keys : L = 0.8 10 <Ctrl + 6> - 3 

<Enter> 
5. Press the keys <Ctrl + Enter> 
 
With the keys <Ctrl + underscore> you can switch Subscript on / off. 
Alternative use <Enter> to leave Subscript region. 
 
The Ctrl key shifts the letters to the alternative font. The example above shows 

that the keys <Ctrl + P> displayed the Hellenic letter Pi (π). 
   

The display shows: 
 

 
 
 

The example above show three important features of RedCrab: the subscript 
mode, the implied multiplication and assignment of a formula to a variable 

(ω=2πf). 
 
 

 
Implied multiplication means you do not need to include the multiplication 
operator  
 

Example:  RedCrab interprets XL = ωL as XL = ω ∗ L 
 

RedCrab interprets a sequence of letters, for example, ab, as different variable. 
Exclude subscript letters, for example XL.  Subscript letters always belong to the 
variable on the left. 
 



Example: 
  abc : a * b * c 
   
  3ab : 3 * a * b 
  
  2XL = 2 * XL 
 
  R1R2 = R1 * R2 

 
 

Use the Escape mode if you want a sequence of letters for a single variable. 
Read more about the Escape mode in the description below.  
 
 
 

1.8 Fraction and Square Root 
 

Enter a formula with a fraction and a square root. 
 
1. Enter the fraction line and the numerator : f = <Ctrl + /> <Enter> 1 <Enter> 
2. Enter the denominator : 2 <Ctrl + P> <Ctrl + 1> LC 
3. Assignment  L : L=0.8 10 <Ctrl + 6> - 3 
4. Assignment  C: C=4.7 10 <Ctrl + 6> - 6 
5. Press <Ctrl + Enter> for result. 
 
The display shows: 
 

 
 
 

To write a fraction line press < Ctrl + / > (forward slash) key. Read more 
information below about fractions in the description. 
 
The keys <Ctrl + 1> write a root symbol at the cursor position, and then mark 
the range which should be below the root. Click the root symbol and the editor 
draw the root line above the marked range. Read more information about square 
roots in the description below. 
 



 
 

1.9 Hexadecimal Input 
 
The RedCrab editor accepts input of hexadecimal numbers up to 13 digits. The 
hexadecimal number must mark with a dollar symbol before it. The use of small 
or capital letters are allowed. 
 
Example: 

$1F2A or 1f2a 
 
You can use a hexadecimal number in any position of a formula like decimal 
numbers. Between the hexadecimal number and the following number or 
variable must be a space or operator symbol. 
 
Example: 

Correct: $1F2A*X or $1F2A X 
Wrong: $1F2AX => generate an error message.



2.0 The Toolbox 
 

 
 
Picture 3.1 
 
 
 

2.1 Fonts 
 

The editor used the New Courier and Symbol fonts. They are usually included 
with Windows operating system. New Courier is the default font. The Symbol 

font includes Hellenic letters and special symbols. 
 

You can toggle between the fonts by mouse click on the < a> and < π�> 
buttons, left on the toolbar, or press <Ctrl + .(dot)> keys. The button of the 
activated font is displayed in blue. 
 
Usually the New Courier font is in use. Alternative font is generally needed for 
certain Hellenic letter. Without switching the font you can type in single letter of 
the alternative font by pressing the <Ctrl> key. Example: press <Ctrl+P> to 

write the character π or <Ctrl+L> to write the letter λ. Conversely, if the Symbol 
font is switched on, press Ctrl key to use New Courier font. 
 
 
 
 

2.2 Font Size 
 

Next to the Font buttons the toolbox show the font size. You can change the font 
size with use of the combo button at the right or write the new font size in the 
box. The maximal font size is 512. 
 
 
 



2.3 Superscript 
 

Use Superscript to write an exponent. Toggle the Superscript mode per mouse 
click on the toolbox <ax> button. With the keyboard you can toggle with 
<Ctrl+6> or <Shift+^>, the <Enter> key leave the Superscript mode.  
 
Following additions were made in Version 1.33:  
 

• Superscript mode can be enabled / disabled using the function key <F3>. 
 

• Superscript mode disabled if you enter a non alpha numeric sign .Same 
thing if you select cells. 

 

• If Superscript is activated when the cursor is on a character, the character 
under the cursor changed from normal letters in superscript.  

 

• Similarly, the character can be reseted by superscript in normal font. The 
superscript mode is not enabled in this case, only the sign is changed. 

 

• As described above you can change selected cells to superscript or reset.  
 
 
 

2.4 Subscript 
 

Toggle Subscript mode per mouse click on the toolbox <ax> button. The 
underscore_ key and <Ctrl+_ (underscore)> toggles Subscript too. The <Enter> 
key leaves the Subscript mode. 
 
Following additions were made in Version 1.33:   
 

• Subscript mode can be enabled / disabled using the function key <F4>. 
 

 

• Subscript mode disabled if you entering a non alpha numeric sign. Same 
thing if you select cells. 

 

• If Subscript is activated when the cursor is on a character, the character 
under the cursor changed from normal letters in subscript.  

 

• Similarly, the character can be reseted by subscript in normal font. The 
subscript mode is not enabled in this case, only the sign is changed. 



 

• As described above you can change selected cells to subscript or reset.   
 
 
 

2.6 Escape 
 

A mouse click on the <Esc> button toggles the Escape mode. You can leave the 
Escape mode with the <Enter> key. If the editor is in Escape and Superscript 
mode the <Enter> key leaves Escape mode only. 
 
Read below the description about Escape mode. 
 
 
 

2.7 DEG / RAD 
 

The < DEG > and < RAD > buttons select the input to a trigonometric function.  
 
< DEG >: input must be in degrees. 
< RAD >: input must be in radians. 
 

The selected button is displayed in blue. 
 
 
 

2.8 Exponent - EXP 
 

If the <EXP> button switched on (displayed blue), the calculator write the result 
as power of ten.   
 
 
 

2.9 Decimal Digits  
 

Next to the <EXP> button you can change the number of decimal digits in your 
result. To change the decimal digits click the up/down button right or change the 
number in the display. RedCrab stores different number of digits for fix- and 
floating point results 
 
 
 



2.10 Fix- / Floating point results 
 

Choose between fix- and floating point results with mouse click on the < FIX > / 
< FLT > buttons. 
 

• FIX  : fix point 

• FLT : floating point 
 
 
 

2.11 Hexadecimal Output 
 
Press the <HEX> button to show results as hexadecimal number. RedCrab can 
display hex numbers up to 13 digits. Any numbers more than 13 digits will be 
displayed as error message. 
 
Left hand zeros of positive numbers will not be displayed. Only one left hand 
<F> by negative numbers will be displayed with a Minus symbol. 
 
Example: 

Decimal: -2 => Hexadecimal Result $FFFFFFFFFFFFE 
Displayed as: $FE 

 
 
 

2.12 Clear 
 

The Clear button prepares the Clear function. Simply press <Enter> to execute 
the Clear function. It’s equal to the <F6> key.  Clear clears the screen, the main 
memory and the undo memory.  
 
 
 

2.13 Reset 
 

Reset clear all calculators output (displayed in blue). It don’t change the user 
input. It’s equal to the <F7> key.   
 
 
 
 



2.14 Enter 
 

Enter start the calculator and display the result. It’s equal to the <F8> and 
<Ctrl+Enter> keys. 
 
 
 
 

3.0 Function Panel 
 

The following part describes the Function panel buttons.  
Alternative you can use the keyboard to execute the panel 
functions. If you are not using the Function panel, you can 
switch this off under the View menu. 
 
Read the description about Escape mode below. 
 

 
 

3.5 Mathematical Functions (Function Panel) 
 
sin() sine  
cos() cosine  

tan() tangent  
arcsin() inverse sine 
arccos() inverse cosine 

arctan() inverse tangent 
deg() convert radian in degrees 
rad() convert degrees in radians 

cot() cotangent  
exp() exponent to Euler's constant : 2.7182818284590452... 
ln() natural logarithms to base  e (2,7182818284590452...) 

log() logarithms base 10 
log2()                  logarithms base 2 
log8() logarithms base 8 
log16() logarithms base 16 

 
 
 



Extended Functions 
 

e Euler's constant : 2.7182818284590452... 

π constant PI: 3.1415.... 

ld() logarithms base 2 

lg() logarithms base 10 (equal to log ) 
log10() logarithms base 10 (equal to log ) 
 
 
 

3.6 Operators 
 
RedCrab uses the operators below: 
 
+  Addition 
-    Subtraction 
*  Multiplication 
/  Division 
 
DIV  Integer number division without remainder. 
MOD  Returns the remainder of the division of integer numbers 
 
 
 
 
 

 

 

4.0 Symbol Panel 
 
The Symbol Panel contained symbols, you can write with 
the keyboard too. But problem may arise by any non 
English keyboard or language. For more information about 
the keyboard read below the description about keyboard 
configuration.     
 

 
 

 

This button writes the Root symbol to the cursor position. It’s equivalent 
to < Ctrl + 1 > key. For more information read paragraph 7.6 Root. 

 

 



 This button writes exponent < 2 > to the cursor position. It is equivalent 
to < Ctrl + 2 > keys.  
 
This button writes exponent < 3 > to the cursor position. It is equivalent to 
< Ctrl + 3 > keys.  
 
This button writes the symbols < *10 > to the cursor position and switched 
in the Super mode to input the exponent. 
 
This button writes the π – symbol to the cursor position. It is equivalent to  
< Ctrl + p > keys. 
 
This button writes a Fraction line to the cursor position. It is equivalent to  
< Ctrl + / > keys. 

 
 This button writes the symbols of an Integral function to the  cursor 

position. It is equivalent to < Ctrl + 4 > keys. 
 
This button writes different brackets to the  cursor position. 
Dependant on selection (small or large), brackets will be 
displayed either in normal font size or triple row size.  

 
Details can be found under paragraph 5.0 Keyboard 
 
 

The Symbol panel contains extra large brackets which are not included in ANSI 

fonts. The following list shows the key codes for the English US keyboard:   
 

 

• Ctrl + '9'   ( Left round bracket 

• Ctrl + '0'   ) Right round bracket 

• Ctrl + '['   [ Left square bracket 

• Ctrl + ']'   ] Right square bracket 

• Ctrl + Shift + '[' { Left curly bracket 
• Ctrl + Shift + ']'    } Right curly bracket 
 
 
 
 
 
 
 
 



4.5 Programmer Panel 
 

The following part describes the Programmer panel buttons. 
Alternative you can use the keyboard to execute the panel 
functions. Read the description about Escape mode below. 
If you are not using the Programmer panel, you can switch 
this off under the View menu. 

 
 
The following Programmer functions and operators perform manipulation 

on integer operands. If the operands real type numbers, the values are 

rounded toward zero.  

 
 
 

4.51 DIV 
 
The DIV operator returns the result of an integer number division without 
remainder. If floating point numbers are entered, the DIV operator cuts off all 
digits after the decimal point before executing the division DIV. 
 
Example: 
 
     11   DIV 3   = 3 

11.2 DIV 3.9 = 3 

 
 
 

4.52 MOD 
 
The MOD operator returns the remainder of the division of two integer 
numbers. If floating point numbers are entered, the MOD operator cuts off all 
digits after the decimal point before executing the division MOD 
 
Example: 
 
     11   MOD 3   = 2 

     11.7 MOD 3.9 = 2 

  

 
 

 



 

4.53 HEX 
 
This button writes the <$> symbol for hexadecimal input to cursor position. 
More information can be found under paragraph 1.9 Hexadecimal Input. 
 
 
 

4.54 AND 
 
The logical AND operator performs bitwise AND manipulation on integer 
operands  
 

Example:     Z = X AND Y 

 
 
 

4.55 OR 
 
The logical OR operator performs bitwise OR manipulation on integer operands. 
 

Example:   Z = X OR Y 
 

 

 

4.56 XOR 
 
The logical XOR operator performs bitwise XOR manipulation on integer 
operands.  
 

Example:   Z = X XOR Y 

 
 
 

4.57 SHL 
 
The SHL operator performs bitwise shift left manipulation on integer operands.  
 

Example:   Z = X SHL Y 



 
The operations X SHL Y shift the value of x to the left by y bits. 
 
 
 

4.58 SHR 
 
The SHR operator performs bitwise shift right manipulation on integer 
operands.  
 

Example:   Z = X SHR Y 

 
The operations X SHR Y shift the value of x to the right by y bits. 
 
 
 

4.59 NOT 
 
The logical NOT function performs bitwise negation on integer operands.  
 

Example:   Z = NOT(X) 

 
 
 

4.60 INCL 
 
The INCL operator adds a bit to the integer operands.  
 

Example:   Z = X INCL Y 
 

In the example above INCL sets the bit number Y in operant X 
 

Example:   8 INCL 3 = 12 

 
 
 

4.61 EXCL 
 
The EXCL operator excludes a bit from an integer operands.  
 



Example:   Z = X EXCL Y 
 

In the example above EXCL clears the bit number Y in operant X 
 

Example:   15 EXCL 4 = 7 

 
 
 

4.62 TRUNC 
 
The Trunc function truncates a real-type value to an integer-type value. The 
values are rounded toward zero. 
 

Example:   TRUNC(123.67) = 123 

 
 
 
 

4.8 Number Panel 
 

The following part describes the Number panel buttons. 
Alternative you can use the keyboard to execute the panel 
functions. 
 

If you are not using the Number panel, you can switch this off 
under the View menu. 
 
 

 

 Clears the actual row at cursor position. If the mathematical expression 
consist several rows, these will be deleted. 

 

 Backspace. 
 

 Linefeed-Return: moves the cursor to the first column at the next free row. 
 

  Space. 
 
All other number and operator buttons function as shown. 



 
 

5.0 Keyboard 
 
The keyboard inputs in the following description correspond to the English 
keyboard and Windows regional and language option English-US. When using a 
non-English keyboard or language, some functions are acquired with other key 
combinations. This concern most of the <Ctrl> key functions. In the attachment 
of this manual you will find pictures about key codes of different keyboards. 
Read the description below about keyboard configurations. 
  
 

 
Esc 

 
Switch to escape mode. 

To exit escape mode: press enter key 
or bracket open  

 
 
 
 
Enter 

-  Exit escape mode  
-  Exit Superscript 
-  Exit Subscript 
-  Moves cursor to numerator, if this position is end of fraction 
bar, 

-  Moves cursor to denominator, if this position in the numerator 
row. 

-  Moves cursor to end of fraction, if this position at the 
denominators row. 

Enter + Ctrl Display result  Equal to the Function  panels Enter 
button  

Enter + Shift Line feed- return : move the cursor to the first used column in 
the next row 

Ctrl + (Shift) switch to alternative font  
Ctrl +  .  Toggle ANSI / Symbol 

font  
 

Ctrl +  ,  Toggle on / off Subscript 
Ctrl + _  Toggle on / off Subscript (equal Ctrl + ,) 
Ctrl + Shift +  , Toggle on / off Superscript (exponent)  
Ctrl + 6  Toggle on / off  Superscript (equal Ctrl +  Shift + ,) 
Ctrl + 9 large round bracket open  
Ctrl + 0 large round bracket close 
Ctrl + [ large square bracket open 
Ctrl + ] large square bracket close 
Ctrl + Shift + { large curly bracket open  
Ctrl + Shift + } large curly bracket close 
Ctrl + / fraction line  
Ctrl + 1 root  
Ctrl + 2 Exponent 2  
Ctrl + 3 Exponent 3  



Ctrl + 4 Integral Formula 
Ctrl + Shift + 4 Integral Symbol 
Ctrl + 5 Function Symbol 
Insert Insert a column at cursor position 
Insert + Shift Insert a row at cursor position 
Delete Delete a column at cursor position 
Delete + Shift Delete a row at cursor position 
Ctrl + Csr left Page left  
Ctrl + Csr right Page right  
Ctrl + Csr up Scroll up  
Ctrl + Csr 
down 

Scroll down  

Ctrl + Page up Move cursor to the first row of the screen 
Ctrl + Page 
down 

Move cursor to the last row of the screen 

  
F3 Enable or disable  Superscript  mode. 
F4 Enable or disable  Subscript mode. 
F5 Clear - clear all,  to demand execution  confirm with  enter (F8) 
F6 Reset – clear the output of the calculator 
F7 Refresh – redraw the screen 
F8 Enter 
 
 
 
 

6.0 The Menu Bar 
 
 
 

6.01 File. Open  
 
Click Open on the File menu. In the Navigation pane, click folder or drive that 
contains the file that you want to open. You can only load file that are saved 
with RedCrab before, with the file extension *.rec. 
 
 
 

6.02 File.Save 
 

If you are saving a changed file click Save on the File menu or press 
<Ctrl+Alt+S>.  



 
 
 

6.03 File.SaveAs 
 

If you are saving the file for the first time use SaveAs on the File menu, the file 
browser prompt for a file name. 
 
 
 

6.04 Print a worksheet 
 
When printing a worksheet, the size of the sheet is fit to the selected paper size. 
The display’s character size does not affect the printout size or quality. 
 
When printing a selected region it is printed in the same font size as above. The 
text will be printed on the top left of the paper. 
 

• 6.04.1 File. Page Setup 
 
With Page Setup you can set the margins width and paper format. 
 

• 6.04.2 File. Printer Setup  
 
Select the printer and the printer settings. 

 
 

• 6.04.3 File. Print  
 
Print the worksheet. You can determine by radio button if the entire 
worksheet or only the selected area will be printed.  

 
 
 

6.10 Edit. Undo / Redo 
 

You can undo and redo your action by clicking Undo or Redo on the Edit menu.  
You can undo and redo up to 100 actions. Undo and Redo is not possible by 
imported object like bitmaps. 
  
 



 

6.11 Edit.Copy / Paste 
 
With the Copy and Paste functions you can copy and insert data within RedCrab 
or from/to external programs. The Copy function copies the selected fields to the 
clipboard. Texts from/to external programs will posted as unformatted ASCII 
text.  
 
Within RedCrab the data are copied in format style. Exception: square root. 
With Paste function only the symbol of the square root is inserted. The range 
belonging to this field must be selected at the new position again. Hence errors 
can be avoided, e.g. only the sub range square of a root is copied and inserted to 
other position. 
 
 
 

6.12 Edit.Paste to Box 
 
For complex technical calculations, it may be useful to include technical 
drawings to mathematical formulas. With Paste to Box on menu Edit you can 
import images and formatted texts from external programs. The image or the 
formatted text is inserted into a box and can be positioned freely. Multiple 
images or text boxes can be inserted. The amount is limited only by resources of 
your computer. 
 
To change a box position, move the mouse pointer on a box, press the left 
mouse button and pull with pressed mouse button the box into the desired 
position.  
 

Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button, and then choose Delete.  
 
Information about the import of images and text files can be found below under 
Menu Insert. 
 
 
 

6.13 Text Box  
 



To edit the text or change the size of text box, text box must be active. Activate 
the text box with double-click of the left mouse button. The background of the 
activated text box will displayed coloured and the text cursor is indicated. 
 

To change the size of the text box, position the mouse pointer on the lower right 
corner of the box and drag the box with pressed right mouse button to the 
desired size. The area to draw the text boxes is displayed with a NW- mouse 
pointer. Information for editing text can be found below at Chapter text editing. 
 
Click the right mouse button to open the text box’s popup menu. The text box 
must be activated first 
 
Popup Menu: 
 

• Word Wrap: Word wrap on / off 

• Lock Text: text edit is disabled. 

• Scroll Bars: scroll bars on / off 

• Font: open Font Dialog to change the font type, size and colour. 

• Delete Text Box: delete the text box.  
 
 
If the editing of the box and text is completed, deactivate the box with double-
click on the left mouse button. 
 
 
 
 

6.14 Text Editing 
 
For editing of text the following table shows a list of keyboard instructions. 
 

Keys Operations 

  

Ctrl+Tab Tab 
Ctrl+Number Pad 5 Select all 
Ctrl+A Select all 

Ctrl+E Center alignment 
Ctrl+J Justify alignment 
Ctrl+R Right alignment 

Ctrl+L Left alignment 
Ctrl+C Copy 
Ctrl+V Paste 



Ctrl+X Cut 
Ctrl+Z Undo 
Ctrl+Y Redo 

Ctrl+'+'  Superscript 
Ctrl+'=' Subscript 
Ctrl+1 Line spacing = 1 line. 

Ctrl+2 Line spacing = 2 lines. 
Ctrl+5 Line spacing = 1.5 lines. 
Ctrl+' (apostrophe) Accent acute 
Ctrl+` (grave) Accent grave  

Ctrl+~ (tilde) Accent tilde 
Ctrl+; (semicolon) Accent umlaut 
Ctrl+Shift+6 Accent caret (circumflex) 

Ctrl+, (comma) Accent cedilla 
Ctrl+Shift+' 
(apostrophe) 

Activate smart quotes 

Backspace Delete previous character. 
Ctrl+Backspace Delete previous word.  
F16 Same as Backspace. 

Ctrl+Insert Copy 
Shift+Insert Paste 
Insert Overwrite 

Ctrl+Left Arrow  Move cursor one word to the left. 
Ctrl+Right Arrow Move cursor one word to the right. 
Ctrl+Left Shift Left alignment 
Ctrl+Right Shift Right alignment 

Ctrl+Up Arrow Move to the line above. 
Ctrl+Down Arrow Move to the line below. 
Ctrl+Home Move to the beginning of the document. 

Ctrl+End Move to the end of the document. 
Ctrl+Page Up Move one page up. 
Ctrl+Page Down Move one page down. 

Ctrl+Delete Delete the next word or selected characters. 
Shift+Delete Cut the selected characters. 

Alt+X 
Converts the Unicode hexadecimal value preceding the 
insertion point to the corresponding Unicode character. 

Alt+Shift+X 
Converts the Unicode character preceding the insertion 
point to the corresponding Unicode hexadecimal value. 

Alt+0xxx  
(Number Pad)  

Inserts Unicode values if xxx is greater than 255.  
Inserts ASCI values if xxx is less than 256  

Ctrl+Shift+A  Set all caps. 
Ctrl+Shift+L  Fiddle bullet style. 
 



 
 

6.15 Edit.Cut/Delete 
 
With functions Cut and Delete on the Edit menu the selected range on the 
computing sheet is deleted. With Cut the range is copied in the clipboard and 
can be inserted in other position again.  
 
 
 
 

6.20 View.Grid 
 

You can show or hide gridlines. Use Grid on the View menu to switch the grid 
on / off. 
 
 
 

6.21 View.Panel Undocked 
 
The function panel can be displayed within 
the main window or as new window. 
This function is activated through Menu 
<View / Panel Undocked> or by double 
clicks on the function panel. 
 
 
 
 

6.22 View.Scientific Panel 
 

All functions on the Scientific panel can also be input with keyboard. You can 
switch it on / off with a click on Scientific Panel on the View menu. 
 
 
 

6.23 View.Programmer Panel 
 

All functions on the Programmer panel can also be input with keyboard. You 
can switch it on / off with a click on Programmer Panel on the View menu. 
 



 
 

6.24 View.Symbol Panel 
 

Toggle the Symbol panel with click on Symbol Panel on the View menu. 
 
 
 

6.25 View.Number Panel 
 

Switch the Number panel on / off with click on Number Panel on the View 
menu. 
 
 
 
 

6.30 Insert.Bitmap File 
 

Load a graphic file. For complex technical calculations, it may be useful to 
include technical drawings to mathematical formulas. Click Bitmap File in the 
Insert menu to open the image file browser and select the image file. RedCrab 
can imports photos from Jpeg files (*.jpg) and  Windows Bitmap files (*. bmp). 
The Jpeg format is not suitable for technical drawings. It creates blurred images 
around edges and errors in the transparency of the images. When RedCrab 
saving files that includes bitmap images, RedCrab compressed images without 
loss and they are usually smaller than jpeg format. 
 
Inserted image is positioned on the top left of the page. You can move it by 
clicking the left mouse button on the image and drag, while holding down the 
mouse button, the image to the desired position. 
 

Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button then choose Delete.  
 
Click the right mouse button to open the image box’s popup menu.  
 
Popup Menu: 
 

• Transparent: displays the image with a transparent background. This 
function works only if the image has a background defined and all 
textboxes in deactivated mode. 

• Delete: delete the box.  



 
 
 

6.31 Insert.Text File 

 
For documentation purposes, text files can be inserted in any position in text 
box. 
 
To load a text file click Text File on menu Insert. It opens a file browser to 
select a file. Files of the type TXT (unformatted text) or RTF (Rich Text 
Format) can be inserted. 
 
The text is inserted in a text box positioned on the top left corner at the 
calculation sheet. To move the text box, position the cursor on the text box and 
press the left mouse key. Then drag the box in the desired position by holding 
down the left mouse button. . Multiple text boxes can be inserted. The amount is 
limited only by resources of your computer. 
 

Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button then choose Delete.  
 
Text boxes are always inserted in a preset size. You can resize the box according 
to text size. It is possible to edit the texts in the text box. For information about 
resize and edit textboxes read Textbox Editing above. 
 
 
 

6.32 Insert.New Textbox 
 
With New Textbox on menu Insert an empty text box will be inserted. To input 
text the box must be activated with a double click of the left mouse button. For 
more information about text box editing read the capital Text Box above. 
 
 
 

6.33 Insert.Textbox to Image 
 
The function text Box to Image converts a text box into an image box. The 
advantage of a graphics box is: 
 

1) The texts cannot be changed. 



2) The formatted text is displayed in original format (similar to a PDF file), 
even if the displayed font is not installed on the user computer. 

 
The function should only be used if it makes sense. By changing the format of 
the file, the file size will be larger.  
 

! Important: This function cannot be reversed! 

 
 
 

6.34 Insert.Show Textbox 
 
The function Show Text box in the menu Insert displayed all text boxes with a 
coloured background. The function is helpful in allocating an empty text box or 
showing the exact positioning. 
 
 
 

6.40 Extras.Page Lock 
 
With Page Lock on the menu Extras, the editor’s page will be blocked for 
additional entries. This function protects unintentional changes made. For data 
input the cells can be unlocked with Unlock Cell. 
 
 
 

6.41 Extras.Cell Unlock 
 
With Unlock Cell on menu Extras cells in a locked page, are unlocked for data 
entry. Select the cells by mouse, and then click Unlock Cell on menu Extras. 
The unlocked fields are marked with an underscore. 
 
To clear the unlocked cells select the cells by mouse, then click Unlock Cell on 
menu Extras. The cells are locked now. 
 
 
 



6.50 Option.Size 
 

You can change the numbers of cells in a worksheet. Use the Size submenu on 
the menu Option. The size can be changed only with an empty page. Once data 
is input, this function is disabled.  
 
You can choose between three sizes of worksheet: 
1. 72 x 72 cells 
2. 144 x 144 cells 
3. 108 x 48 cells 
 
 
 

6.51 Options.Autocalc 
 

When Autocalc is enabled, the results of the mathematical expression displayed, 
when equal sign is entered, like conventional calculators. It only displays results 
that have a value, not just consist of undefined variables. Exempt from the 
automatic calculation are complex functions, such as integral, because the 
calculation may take several and would bother entering complex formulas. 
 
 
 

6.54 Option. Keyboard 
 
The keyboard input in this description refers to an English keyboard in the 
country's setting English-US When using a non-English keyboard or language, 
some functions are acquired with other key combinations. This concern most of 
the <Ctrl> key functions.  If you have problems with the assignment of the keys, 
click Keyboard in the Options menu. It opens with a list of alternative 
keyboards, which differ significantly in important features of the English 
keyboard. Here you select a keyboard that corresponds to your specification. 
Attached you will find images about key codes of the alternative keyboards and 
the occupancy of the Ctrl functions. 
 
 
 

6.55 Option.Display Buffer 
 
RedCrab works with a dual screen memory. This will scroll faster and flicker is 
avoided. However, this feature works only on new generation computers and 



video cards. On older computers, it can lead to slower response to inputs. In this 
case, it is convenient to click Display Buffer on Option menu to eliminate this 
feature. 
 
 
 

6.56 Option.Column Space 
 
The menu Column Space opens a dialog window to set the 
minimum distance between two formulas in a row. The 
minimum value you can set is 2 columns. RedCrab displays 
the value in the bottom, right corner, next to the keyboard 
setting. You can also open the dialog window with click on 
the number. 
 
 
 

6.90 Help.About RedCrab 

 
Display the version number and license. 
 
 
 

6.92 Help.Check for Updates 
 
Compare the version of the program with the latest version on the RedCrab 
server. It displays a message if an update is available. To use this function you 
must have an online connection. 



7.0 Work with RedCrab 
 
 
 

7.1 Start up 
 

After program start RedCrab display an empty page, similar to an empty sheet of 
paper. In its basic setting the size of the arithmetic field are 72 x 72 cells. This 
corresponds approx. to one 12” or DIN A4 sheet with average type-size. The 
size of the arithmetic field can be changed in the menu Option / Size to 108 x 48, 
or 144 x 144 cells. 
 

!  The size of the arithmetic field can be changed only with empty screen. After 

input this function is blocked. 
 
RedCrab store the current size in use. So after a new start of the programmed the 
previous setting will be displayed. 
 
 
 

7.2 Write a Mathematic Expression 
 

A mathematic expression can be written at any position. It is important that 
enough space remains to express the result.  
 
Between each assignment and formula, there must be at least one blank line in 
between, or the assignment must be marked with a colon in the first column. 
 
Example 1: 
 

x = a + b = 

 

a = 10 

 

b = 12 

 
 
Example 2: 
 

  x = a + b = 

: a = 10 

: b = 12 

 



 
 
The result is written to the right of the assignment after the second equal sign. If 
on the right is no equal sign, RedCrab displays no result. 
 
Format in the extension mode: 
 

x=a+12= 
 or  x=a+12 
 
Several different tasks or expressions can be entered. By setting the right equal 
sign, you can determine which results or intermediate results to be printed. 
 
 
 

7.5 Fractions 
 
Entering a fraction line: Press the keys <CTRL + /> (Ctrl + Slash) and a three-
character fraction bar will be displayed. By repeatedly pressing the keys the 
fraction bar is extended by one character forward. In general, it is sufficient if 
you continue entering data above and below the fracture line. When typing the 
numerator or denominator data, the fraction bar is automatically extended by the 
editor as far as it is required. 
 
The input of data is supported here by the text editor. If you have taken the 
fraction line, the cursor is in the first column after the line. Press in this position 
<Enter> key, the cursor moves over the slash to the first position of the 
numerator. After entering the numerator, press again <Enter>, the cursor jump 
to the first position of the Denominators. After entering the data press <Enter> 
again. The cursor jump back into the column right of the fraction line. 
 

! The fraction bar must exceed at least 1 character front and rear. 

 
Examples: 
 

  123   wrong 
  abc 
  

  123  correct   
   abc 
 
 
 



7.6 Root 
 
Set the root character with the keys <CTRL + 1> to the desired position. Then 
mark the area which is to be included under the root. Finally set the cursor on 
the root of character, the editor draws the root symbol over the marked area. 
 
For one-line root calculation, the following steps apply: 
 
1. Set root symbol with <CTRL + 1> . 
2. Enter the data 
3. Holding down the Shift key and with <Cursor-left> key reposition to the root     
sign. 
 
The editor draws the root symbol over the marked area. 
 
 
For multi-line data in the root (e.g., fractions): 
 
1. Set root symbol with <CTRL + 1>. 
2. Data entry. 
3. Mark the area for the root with the mouse. 
4. Click the mouse on the root symbol. 
 
The editor draws the root symbol over the marked area. 
 
In order to highlight the area, it is sufficient if the last column under the root is 
marked. 
 
To change the area under the root, highlight, as described above, the new field 
and then click the cell of the root sign. The roots then marked the new area. 
 
By double-clicking on the root symbol the root lines around the data is removed. 
 
 
 

7.7  Escape Mode 
 
RedCrab works as described above with implied multiplication. A sequence of 
letters be regarded as a single variable and be multiplied. If it is necessary for a 
variable or a function to use a name with more than one letter use the Escape 
mode. The Escape mode is activated by pressing the ESC key. All these 
characters are then interpreted as one word, until the Escape mode is switched 



off. To cancel ESC, press Return or '('. The screen will be printed bold 
characters in Escape mode. 
 
If an Escape variable follows a bracket you must set an operator before the 
bracket. Escape name followed by a bracket without operator is usually 
interpreted as a function call. 
 
For example: correct: sin (12 + a) 

correct: six * (12 + a) 
wrong: six (12 + a) 

 
 
Different Esc names must be separated by SPACE or operator; otherwise they 
are interpreted as a word 
 
For example:  correct: apple * banana 

correct: apple banana 
wrong : applebanana 

 
 
 

7.8 Integral  
 
For calculating the area of a curvilinear region RedCrab provides termed 
definite integrals. The Integral must be formatted as below: 
 

 
 
 
The input of the integral is simple. Press the <Ctrl + 4> keys and RedCrab 
display the complete integral formula on the screen shown above. Now you can 
overwrite or complete the formula as appropriate. See the example below. 
 

 
 
 



The names of the variables are interchangeable. For example instead of <x> you 
can chose <t>, which does not change the value of the integral.  
 
In complex calculations, the function (integrand) can be outsourced and assign 
with a reference variable. 
 
For example: 

 
 
 
In the example above, <z> represents the function of the integral. The allocation 
of <z> to the right of the equal sign must always be enclosed in brackets. 
 
In the example above, the integration limits <a,b> > have been overwritten with 
values <0, 90 >.When overwriting the variables, it must be noted that as shown 
in the example, only one-line concept can be used (without fraction) and the 
term with no spaces must be written directly to the integral sign. The values of 
the limits of integration may alternatively be assigned outside of the integral to 
the variables <a> and <b>. 
 
For example:  
 

a=0     

 b=90     
        
 
By default the subdivision of the calculation is in 360 units. The division can be 
changed by the variable <d > when assigned a different value.  
 
For example: 
 
 d=1000 

 
 



Functions assigned to keyboard: 
 
 Integral (formula): <Ctrl + 4> 

Integral symbol  : <Ctrl + Shift + 4>  
Function symbol  : < Ctrl + 5> 
 

Typical accuracy by a sinus calculation: 2/ d2 

 

 

 

7.9 Error Messages 
 

For error location RedCrab marks the cell in where an error is detected with a 
blue frame. It also marks the incorrect formula with a red frame. 
 

 
 
 
The marking of the entire formula simplifies the localization of errors that cause 
a false positioning. In the example below, an invalid assignment is signaled. The 
red selected box indicates, however, that two formulas were joined because the 
distance is too close. In this example the adjustment of the distance (column 
space) is 4 columns; the distance between the formula is only 2 columns. 
 

 

 



Attachment 
 
 
Key Code  Configuration 
 
 
 

US-English 
 

 
 
 
 

German 
 

 
 
 
 



Italian 
 

 
 
 
 

Brazil (Portuguese) 
 

 
 
 
 
 
 
 
 


